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iPad Supported Formats 
iPad - is now the hottest tablet computer from Apple. The

9.7-inch high-resolution screen makes iPad perfect for watching HD

movies, TV shows, podcasts, music videos, reading and more.

However, the formats supported by the iPad are relatively

limited compared to the number of formats available on the market.

So what are iPad supported video, audio, TV and ebook formats?

Read this tutorial to learn what are iPad supported.

iPad Supported Video Formats

H.264 video (up to 720p, 30 frames per second; main profile

level 3.1 with AAC-LC audio up to 160 Kbps, 48kHz, stereo audio in

.m4v, .mp4, and .mov file formats)

MPEG-4 video, up to 2.5 Mbps, 640 by 480 pixels, 30 frames

per second, Simple Profile with AAC-LC audio up to 160 Kbps, 48kHz,

stereo audio in .m4v, .mp4, and .mov file formats.

Motion JPEG (M-JPEG) up to 35 Mbps, 1280 by 720 pixels, 30

frames per second, audio in ulaw, PCM stereo audio in .avi file

format .

iPad Supported Audio Formats

AAC (16 to 320 Kbps); protected AAC (from iTunes Store)

MP3 (16 to 320 Kbps), MP3 VBR

Audible (formats 2, 3, and 4)

Apple Lossless

AIFF; WAV

iPad Supported TV Formats

Support for 1024 by 768 pixels with Dock Connector to VGA

Adapter;

576p and 480p with Apple Component AV Cable;

576i and 480i with Apple Composite AV Cable.

iPad Supported eBook Formats

ePub - This open iPad eBook format is used by many online

stores. You can also convert other formats to ePub and then sync

them to the iPad via iTunes.

PDF - PDF is the reigning downloading document format on the

website, so you're likely to find ebooks in this format. The iPad

lets you

transfer PDF to iPad and read them via

third-party apps.

iBooks - The books purchased through the iBooks Store are

actually in ePub format, but include DRM to prevent unauthorized

sharing or copying.

Kindle - Amazon's Kindle isn't just an ereader that competes

with the iPad, it's also an ebook format. Though you can't read



Kindle books through the iBooks apps, you can read them on the iPad

using Amazon's Kindle app.

Barnes & Noble - Just like with Amazon, Barnes &

Noble has an app that lets you buy read books purchased from their

online store on the iPad.
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iPad music and eBook apps 
<p>If you do have an iPad or are planning on getting one, you

should know that you are in for a wonderful world of music and

eBooks-centric applications to play with. Following list shows top

8 iPad music apps and

<b>iPad ebook apps</b> for you.</p>

<p

style="font-weight: bold">iPad music apps</p>

<p>

<b>1.</b> StreamToMe</p>

<p>The StreamToMe application lets you use your iPad to play video

and music files - in a wide variety of formats without prior

conversion - streamed directly over WiFi from your Mac or PC. If

you connect the video-out cable for iPad, StreamToMe can play

through your TV, turning your iPhone/iPod plus Mac/PC into a

home.</p>

<p>

<b>2.</b> Shiny Drum</p>

<p>Shiny Drum is a music application for iPhone, iPod touch and

iPad designed by OutOfTheBit and Leo Di Angilla, the creators of

Vintage Drum (app featured by Apple in many countries), iBongos,

iCongas, iTimbales, iPandeiro.</p>

<p>

<b>3.</b> TabToolkit</p>

<p>TabToolkit for iPad is an Apple Design Awards 2010 winner!

TabToolkit is an incredibly powerful guitar tablature and music

notation viewer, now with multi-track playback! An essential tool

for learning and practicing music, TabToolkit includes an audio

synthesis engine so you can listen to and control the audio for all

tracks individually.</p>

<p>

<b>4.</b> Beatwave</p>

<p>Create amazing beats and tunes without any musical ability using



Beatwave for iPhone, iPod Touch and iPad.

<br />Using just your finger, you'll be turning out wicked tracks

for

<b>FREE</b> that amaze your friends and family, in no time at

all!</p>

<p>

<b>5.</b> Pianist Pro</p>

<p>Pianist, the ORIGINAL iPhone piano, turns Professional in an all

new iPad-only app with photo-realistic graphics and an unbelievable

sound. Recommended by The New York Times, The Independent,The Daily

Telegraph, and Rolling Stone Magazine, Pianist Pro was the number

one music app for the iPad at release and has remained high in the

charts ever since.</p>

<p>

<b>6.</b> Pandora</p>

<p>Pandora Radio is your own free personalized radio now available

to stream music on your iPhone or iPad. Just start with the name of

one of your favorite artists, songs or classical composers and

Pandora will create a "station" that plays their music and more

music like it.</p>

<p>

<b>7.</b> SoundHound</p>

<p>SoundHound is instant music search &amp; discovery. This free

version gives you unlimited voice and text searches, unlimited

lyrics, and 5 free super-fast music recognition searches every

month.</p>

<p>

<b>8.</b> PatternMusic</p>

<p>Create compelling, original music on your iPad&trade; with

PatternMusic&trade; MXXIV. PatternMusic was designed to inspire

creativity, learning and experimentation in music enthusiasts and

experts alike</p>

<p

style="font-weight: bold">iPad eBook apps</p>

<p

style="font-weight: bold">Book</p>

<p>Has the nicest landscape mode and is the only app which allows

in app purchasing of books.</p>

<p>You can also add your own content via iTunes so long as the

content is in epub format. Does not allow annotations. App is

free.</p>

<p

style="font-weight: bold">Kindle</p>

<p>This is the only

<a

href="http://www.ipad-books-download.com/ipad-ebooks-download.html">iPad



eBook download</a> app that allows you to take annotations or notes. It also

allows synching across devices. New content can be purchased via

the Amazon store but not within the app itself.</p>

<p>

<b>Note:</b> You cannot add old content or content purchased at

other vendors unless you own a Kindle reader.</p>

<p

style="font-weight: bold">Kobo</p>

<p>Nice interface but limited by way of content.</p>

<p>Not all content you purchase can be viewed in the App. There is

no way to add old content or content purchased at other

ebookstores. App is free.</p>

<p

style="font-weight: bold">Bookself LT</p>

<p>Allows you to easily add your own content via iTunes, over the

air using Bonjour or via a webserver like feedbooks or your own

created calibre cloud catalog.</p>

<p>The LT version has an ad at the top but is free. Has

autoscrolling. The paid version is $4.99.</p>

<p

style="font-weight: bold">ReadMe</p>

<p>Easy access to online catalogs including your own calibre

generated cloud catalog.</p>

<p>No bookstore access &amp; thus new books cannot be purchased and

added without computer access. App is $1.99.</p>

<p

style="font-weight: bold">GoodReader</p>

<p>Great for reading PDFs, Word Docs, and other supported formats

but does not allow interactivity.</p>

<p>You can add content a multiple of ways including accessing the

attachments in your email box. Does not read ePubs.</p>
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Device drivers 
A device driver is a program that controls a particular type of

device that is attached to your computer. It consists of software

code that allows your PC's operating system to interact with a

hardware device. Every device driver performs a different function

due to the fact that there are so many peripheral devices that

connect to your PC's operating system. Peripheral devices are



devices such as printers, hard drives, scanners and keyboards. The

device driver provides a way for your PC to communicate with the

peripheral device.

How does a device driver work?

For example, let's say you want to print a document to your

printer. Windows accesses the Function Dispatch Table for the

function code required to carry out this task. It then sends a

request to the appropriate device, in this case your printer.

Requests are called IRPs or Input/Output Request Packets. When the

printer driver receives and IRP, it does one of three things: it

either understands and does its function followed by sending a

confirmation notice that the job is complete; it accepts the

request and places it in a queue (if the device is busy doing

something else); or it notifies Windows that there's a problem and

it cannot perform the request.

Generally, device drivers operate in a mode called "kernel"

mode. Windows handles program codes in either user or kernel mode.

User mode is typically used for programs. When using user mode,

programs can call and use services provided by the operating system

but cannot access the hardware directly. Processes running in

kernel mode can interact with system memory and hardware.

Advice about device drivers

Like computer programs, device drivers and hardware can cause

computer crashes and instability which needs to be fixed by

replacing or updating a device driver sometimes to solve the

computer and hardware problems. Therefore, it is important to note

that before you install a device driver it is a good idea to check

the website of the manufacturer for the peripheral device to make

sure that you have the right

driver updates

available.

You can also check to see if the driver has been digitally

signed by Microsoft which means the driver has been approved by

Microsoft for compatibility with the Windows operating system. You

can check the signature by clicking on "Start" on your main toolbar

on the desktop and then clicking on "Run." Type "sigverif" into the

command prompt to run a scan of all of your device drivers and to

verify which drivers contain signatures.
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Driver issue fix-reinstall or updat 
What is a driver?

A driver is a program that controls a particular type of device

that is attached to your computer. It consists of software code

that allows your PC's operating system to interact with a hardware

device. Every driver performs a different function due to the fact

that there are so many devices that connect to your PC's operating

system. A driver provides a way for your PC to communicate with the

device.

Driver issue and fix

If a device isn't working properly, this probably indicates that

the driver you installed for it is incorrect or out-of-date. In

this case, we need a right and new driver which is stable,

functional, secure and compatible with windows to ensure proper

operation of the supported device for the computer.

How to get the driver we need?

Before reinstallation or update, we need to get a correct and

new driver. Here are four sources for the driver we need.

1. The manufacturer's site

It's the best place to get drivers for any device.

2. A driver download website

It becomes a popular source to download drivers nowadays.

Actually, they download drivers from the device manufacturer's

site, organize them, thus make them available to visitors.

3. Windows Update

It's another working driver download option. Since the drivers

are downloaded and installed automatically as part of the Windows

Update process, you don't need to download them in the typical

sense.

4. A third-party developer

Last but not the least, a third-party developer. These driver

developers usually are not affiliated with the hardware device

manufacturer or the operating system company. They just

specifically design the software like a

driver updater to

work with a particular piece of hardware. Usually, the drivers

downloaded are safe and well-tested.

How to reinstall or update?

After we get the correct driver, we are now reinstalling or

updating it.

Steps on how to reinstall a driver:

1. Log on to your computer as an administrator

2. Click Start, right-click My Computer, and click Manage. Under

System Tools, click Device Manager

3. In the right pane, expand any of the categories to find the



hardware you need to reinstall, right-click the device, and then

click Uninstall. In the Confirm Device Removal dialog box, click

the OK button

4. If you see a message asking if you want to restart your

computer, click Yes. You can also manually restart your computer

instead. After restarting your computer, Windows will automatically

detect and reinstall the hardware you need to reinstall.

Steps on how to update a driver:

1.       Open Windows Device

Manager

2.       Locate the device you

wish to update the drivers for and right click it, Click

Properties

3.       In the Properties window,

click the Driver tab and click the Update Driver button

4.  In the Hardware Update Wizard, point Windows to the

location of the updated drivers on your hard disk drive., the

drivers will be updated.
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How to update your drivers? 
 

 When we come across driver issues, normally we will go to the

 manufacturer's site or use Windows Update for right driver

 updates to fix the problem. However, what should we do if neither

 way works?

 Actually, driver updaters are very popular programs which can

 help you update your drivers automatically and easily. Here take

 Driver Robot for example to guide you how to use a driver update

 software to update your HP drivers.

 

 Step 1:

 download & install Driver Robot

 To start the automatic driver updating process, you first need

 to download the Driver Robot setup file from here: Driver Robot

 setup (executable, 5.1MB). The setup file will take 20-30 seconds

 to download on to your computer. When it is finished, find it on

 your HP computer and run it.

 Notice: Once Driver Robot's setup program is running, you

 should see a screen welcoming you to the installer. Press "Next"



 to continue to the End User License Agreement (EULA). You have to

 say "Yes" to this agreement in order to proceed; press "Next"

 when you're ready.

 As soon as you agree to the EULA, Driver Robot will begin

 extracting on to your system. Rest assured that this installation

 process is 100% reversible. The moment Driver Robot is finished

 installing, it will run automatically and offer to scan your

 system for new HP driver updates.

 

 Step 2:

 Initial system scan

 Right after you install Driver Robot, it spends about 2

 minutes scanning and identifying your HP computer's hardware. It

 also looks at the age and accuracy of the drivers you currently

 have installed.

 Driver Robot uses this data to compare your system to its

 massive driver database in order to make recommendations.

 

 Step 3:

 Driver scan results

 

 After Driver Robot is finished scanning your system for

 missing or out-of-date HP drivers, it reports its findings to

 you.

 It's here that Driver Robot makes recommendations regarding

 updates to your computer's drivers. Driver Robot always

 recommends the latest official drivers

 .

 

 Step 4:

 Driver download and installation

 

 Driver Robot now downloads and installs the latest device

 drivers for your PC, directly from the manufacturer. The

 installation process is fast and easy.

 If you a DELL, ATI or ASUS user, you can also update your

 DELL drivers,

 ATI drivers or

 ASUS drivers easily and

 correctly the way updating

 HP drivers.

 Driver Robot is with massive driver database, fast scan

 technology and great user interface, this make it the industry

 leader in driver scanning. With Driver Robot, you can always be

 guaranteed to receive the latest official drivers.
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How to find drivers for HP Printer? 
 

Now

if you just purchased a new retail version of HP printer, it likely

came with a compact disc with the

hp printer

drivers

installed.

However, if for some reason, you've lost it or picked up the

Officejet 6000 Wireless Printer used and without the drivers, this

article will tell you where to find the correct drivers.

First, let's try the manufacturer's website. Most computer

hardware peripheral product drivers can be found directly on the

manufacturer's website. So let's check that out. First, go to

 

 www.hp.com

, then, on the top of the page near the center we're going to

click on where it says, "support and drivers", next, we're going to

choose the "download drivers

and

software (and firmware)" option and click on that dot to choose it.

Then where it says, "Enter a product name/number", type "Officejet

6000 Wireless" and click "go". Now we see a screen where it lists

most of the current computer operating systems. Windows xp, Windows

Vista, and the new Windows 7 are among them. Assuming you are aware

of what operating system you have, find your operating system and

click on it. (If you don't know, it is explained how to find out

what operating system you're running below) You'll now see a list

of drivers. My suggestion would be to choose a right driver

update

software.

You'll have the choice of an English language only version or

multiple languages. Choose the one that you want.

Now you'll see a user agreement that you may read if you wish

and the file itself at the top of the page. Click on the file

following the words..."File name". Pay attention to where it is

saved to. After it's finished downloading, find the file, double

click on the file and go through the self explanatory installation.

Now let's find out what operating system you have on your PC.



If you are unaware what operating system you are using,

here's how you find out. On your Windows PC, click the "start" menu

on the bottom left corner of your computer screen. Choose "Control

Panel". If your view is in the "category view", click on

"performance and maintenance", and then click "system". Your system

properties should pop up. Click on the "General" tab at the top of

the window if it's not already selected. On the top where it says,

"System" your operating system should be listed. If you view your

control panel in the "classic view" choose the "system" icon and

the identical information will appear.

So do you have it all installed? How's your new printer

working? Hopefully, you're in the midst of a printing frenzy. If

you're having any trouble in finding correct

printer drivers

,

feel free to contact HP technical support. In the USA, you can call

them twenty four hours a day, 7 days a week at 1-800-HP invent.

When you call, have your printer's Serial Number (S/N), product

name, model number, and a description of what's wrong.

Good luck and don't worry. We'll have you up and printing in

no time.
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iPad tips 
Tip 1
How to Transfer Local eBooks to iPad with iTunes?
Reading local eBooks on iPad is an amazing experience. If you
have some eBooks on your local computer, you can transfer them to
iPad via iTunes. Here is the guide shows you how to transfer local
eBooks to iPad with iTunes.
Step 1. Put your eBooks into iTunes books library
Launch iTunes on your compute, go to File > Add File to
Library
... or File > Add Folder to Library.
.. to add local ePub eBooks or folder to iTunes Book
Library.
Step 2.Connect your iPad to PC
Connect your iPad to your PC via USB cable.
Step 3. Transfer eBook to iPad with iTunes
Click on your iPad in the source list under Devices. Then click



the Books tab at the top of the window. Here you can choose whether
to sync all books or selected books. And then click apply button,
you can have your selected
iPad Books
successfully synced.
Tip 2
How to Import Document to Pages for iPad?
Creating a new document in Pages for the iPad is easy enough -
but what if you want to work on an existing document that you
created on your Mac or PC? Is there any solution to import
documents to pages on iPad?
To import existing documents to Pages for iPad, there are mainly
three ways. One is to make it as an email attachment. Two is to
download from the web. The third is toimport document to Pages for
iPad from a Mac or PC using File Sharing in iTunes, which is what
we talk about in this tutorial.
Step 1: Connect iPad and Select Apps
Make sure your iPad is connected to your Mac or PC and select it
in iTunes.Then Select Apps tab on the top.
Step 2: Select Pages on iPad
From the Apps list in the File section, select Pages. By
default, you should see one document - Getting Started.doc.a This
is the document that Pages for the iPad comes with. To upload a
file to your iPad so you can edit it with Pages, click the add
… button.
Step 3: Import Document to Page for iPad
Navigate to the document you wanted to transfer to your iPad,
select it and click the choose button.
Step 4: Import Document to Page for iPad
To export, or download documents from your iPad to your Mac or
PC - select the file from the Pages Documents column and click the
save to...button.
Step 5: Save the Document
Select a folder to save the document from Pages and click the
choose button.
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Getting drivers for unknown devices on manufacturer's site 
Visiting the hardware manufacturer's support site for driver
help is very common. But what if we don't know the make/models of



the component?
 
Here are 4 ways to solve the dilemma.
 
1. Accessing the System Information Menu
 
For Windows XP and Windows Vista, the steps to access the
System Information menu on a PC are relatively the same. They are:
Click on the Start button→All
Programs→Accessories→System Tools→System Information
 
2. Examining the Set Up menu at boot up time
 
When you start up your system, usually a message will flash
across the bottom of the screen letting you know what to do to
enter the system set up menu. Most of the time, you just need to
press a function key like F2. In some cases, there is actually a
button specially designed for this purpose, such as a blue button
on some laptop models.
 
With this function, you will get the necessary information
for identifying the motherboard and BIOS (basic input/output
system).
 
3. Running systems diagnostic tools
 
DrWatson is a common systems diagnostic tool that is
installed on many computers when you buy them. There are other
programs too. Whatever the program is, make sure that it is virus
free and appropriate for the operating system you are using.
 
Usually, these programs will provide troubleshooting, better
and more understandable information than your operating system.
 
4. Using information from the make/model/serial number label
to locate specific parts on vendor website
 
Computer manufacturers may have chosen to use several brands
of the same component. So, if you are familiar with the component,
look the make, model or series information up on a few popular
component websites.
 
This should give you a part or list of parts that could be
used on your computer. If you see the same part manufacturer and
model number show up in several places, probably that's the
information you are looking for.



 
Besides, we can also use a right driver update software to
get drivers for unknown devices on manufacturer's site
 
 
Driver update programs
(like Driver Robot) actually download drivers from the device
manufacturer's site, organize them and make the driver needed
available for visitors. Therefore, a good
driver updater can
help you get the correct drivers indirectly but automatically and
easily from the manufacturer's site.
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Top 10 Best Free iPad Apps 
 

 

   1.

   Red Ball

 

 

 

 This

 highly addictive game isn't the number one most downloaded free

 iPad

 app for nothing. While the game-play controls need a bit of

 improvement, it's a pretty fun game, especially considering the

 price.

 

 

 

 2.

 

Facebook

 

 Apple's

 senior vice president of iPhone software, Considering that anyone

 with a decent amount of Facebook friends can access a wealth of

 profiles, updates, photos, and more, you can use it to be the

 hippest stalker ever.



 

 

 

 3.

 

Flickr

 

 Flickr

 has always been a great resource for photographers and

 photography fans. With Flickr on the iPad, you'll be able to

 cycle through Flickr's amazing collection of photos with a much

 bigger screen.

 

 

 

 4.

 

NBC

Olympic

 

 With

 the Winter Olympics just a few short days a way, this new app

 from NBC will let you keep up with medal counts and updates on

 all of the action from Vancouver. The app will also allow viewers

 to access video highlights for free.

 

 

 

 5.

 

AP

Mobile

 

 If

 you want to take a break from the New York Times iPad app, then

 check out AP Mobile. This comprehensive app offers

 stories,photos, videos, and more. With the larger screen, videos

 & photos around the globe are bound to pop more.

 

 

 

   6.

   Virtuoso Piano Free

 

 

 



 Here's

 an app that looks a bit like the life-size piano from the movie

 Big (when compared with how it looks on the iPhone). It's also

 not just for seasoned musicians. The app helps you learn to play

 the piano by labeling the keys by their notes.

 

 

 

 7.

 

Kindle

 

 If

 Apple plans to let Kindle stay on the iPhone/iPad platform, the

 Kindle app would be a good alternative to Apple's new iBooks

 bookstore. All the Kindle users out there who want to give the

 iPad a spin but want access to all their Kindle-format ebooks

 might best appreciate this app.

 

 

 

 8.

 

Epicurious

 

 Love

 to cook? If so, the Epicurious iPad app is made for you. This App

 lets you brows recipes (complete with delicious looking pictures)

 and create shopping lists for the ingredients you need.

 

 

 

 9.

 

Box.net

 

 With

 a free Box.net account you can share and collaborate on all types

 of files, making it a perfect app for students or employees who

 need to collaborate on documents or projects.

 

 

 

 10.

 

Shazam



 

 The

 Shazam iPad app recognizes the song for you and lets you listen

 to previews and purchase the tracks. The iPad version features

 faster song recognition and, for a limited time, the launch

 version includes unlimited tagging.

 

 

 

 For

 more information about iPad, you can check out this site

 for 

 iPad books

 download.
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How to fix common driver problems 
A driver is a small software program that allows a hardware

device to communicate with a computer.  When hardware

installed in or attached to a computer doesn't work properly, it is

often because of a driver problem.

Here are some common problems with drivers, and tips to solve

them.

I just installed a new hardware device, and it's not working

correctly.

If hardware isn't working properly, you might need a new

driver-whether you installed the device recently or have had it

installed since you acquired your computer. Every device needs a

driver that allows it to communicate with your computer. Sometimes

drivers need to be updated. All your drivers must be compatible

with this version of Windows.

Usually, you can find the driver you need on the disc that came

with the hardware or device you want to use, or on the

manufacturer's website. Also, drivers come with Windows or can be

found by going to Windows Update in Control Panel and checking for

updates.

There are several things you can try if you have a device that

is not working correctly:

Make sure that the hardware device is compatible with your



computer and with your version of Windows. If the device is not

compatible, you will need to find the correct driver. Check the

information that came with your device.

Many devices require special drivers to work properly. Be sure

that you have installed any software discs that came with the

device.

Restart the computer. Restarting might be necessary if the

driver requires it or if the driver did not install correctly.

My device used to work, but now it doesn't.

There are several things you can try:

Go to the manufacturer's site to see if an updated driver is

available for your device. So, if it's a Dell, go to dell.com for

the

Dell drivers you need.

Find the disc that came with the device and place it in the

computer's CD drive to update the driver for the device.

Use Windows Update, the updated drivers might be available.

Update the drivers with a

driver updater, it

may help you get the

driver updates you need

automatically and correctly.

I can't connect to the Internet to update my drivers.

If you do not have a connection to the Internet, you might need

to update your network driver manually. If you have the disc that

came with the device, place it in the CD drive and manually update

the driver.

If you can't find the disc, try to connect to the Internet from

another computer and download the device driver from the device

manufacturer's website. Once you have the device driver files, copy

them to the computer with a problem.
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